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Project Execution vs Present Information System MyEpcTeam
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Project I_Executlor_1 & Present Information Solutions
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Core Team MyEpcTeam

« Saroop Chand (Chairman)

Founder and Chairman of the group, leading the group since 1988 and expanded to 6
companies in India and US. Delhi University alumni, an MBA from Delhi School of Economics

Email: saroop.chand@adroitecinfo.com Phone: +91 9810111540

 Mahesh Chand (Advisor)

30+ years of experience in leadership roles, specifically Finance, Operations and Consulting.
Worked with organizations at key positions in Essar Group, Deloitte.

Email; mahesh.chand@adroitecinfo.com  Phone: +91 9810600626

* Nitin Gupta (Co-Founder & Director)

Planning specialist with 15 years of experience in Project Planning and Control with
organizations like Tata Consulting Engineers, Reliance Jio, Indiabulls Power etc

Email: nitin.qupta@myepcteam.com Phone: +91 9987671199
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Core Team MyEpcTeam

» Sunil Vaishnav (Co-Founder & Director)

EPC Erofes_sional with more than 30 years of experience in various types of industries in India and abroad. He has
worked with EPC organizations like Genelec Ltd, Punj Lloyd Ltd ,"Reliance Infra, Indiabulls Power etc. He has
extensive work experience in Oil and Gas and Thermal Power Sector.

Email: sunil.vaishnav@myepcteam.com Phone: +91 9811115163

» Shashi Verma (CEO)

PMP certified project management professional with excellent combination of business, domain and
technical skills, having experience of more than 18 years across different disciplines of IT, technology,
operations, project/program management. Led consultancy and dellvep/ of various Project management
solutions to the clients across globe and multiple verticals i.e. Pharma, EPC, Energy, Food & Beverages etc.

Email: shashi.verma@myepcteam.com Phone: +91 9958291201

 Priyanka Gupta (Consultant)

Leading architect with 12+ year of experience. Worked with organizations like Jindal Group, Pizza Hut.

* Parul Gupta (Consultant)

En?_ineering graduate from Delhi college of Engineering. Worked as IT Consultant with organizations like
HCL Technologies.
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Company Overview MyEpcTeam

Part of Adroitec group established in 1988

All India spread with offices across India (Bengaluru, Mumbai, Hyderabad, Noida, Chennai,

Kolkata, Pune, Coimbatore), which helps us to closely work with the customer.

Engaged in IT Consulting of Infrastructure and Engineering Businesses

Represents Oracle, PTC, Bentley, HP, ZWSOFT etc.

Rich Experience in project planning, execution and IT implementation related to project
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MyEpcTeam

A Cloud Based Integrated Project Management Solution For Construction Industry

- Schedule Management - Contract Management
- Engineering Management - Construction Management
- Procurement Management - Issue management

C-130 Sector-2

Noida, India

Pin-201301

Tel: +91 120 4864300

Fax: +91 120 4864333
Email: info@myepcteam.com
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Current Solution

Planning and
Scheduling

Issues,
Hindrances,
Safety and

Quality

Construction

Management

Contract
Management

Site Execution

DMS for
Drawing and
Document
Management

MyEpcTeam

Disparate system which operate in
Silos

Major companies implemented ERP to
handle finances and procurement to
ensure integration

Do we not need the same in Project
management ?
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MyEpcTeam

User
Management

Integrations Project Planning

Timesheet Engineering

MyEpcTeam

Progress Photos Procurement

Issues/Hindrances Construction

Dashboard/Repor  Contract, Budget
ts & BOQ

MyEpcTeam

Open system for any customisation
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User Access Management MyEpcTeam

e 3 Dimensional User Access
* Project Level
* Role Level (PM, Document, Procurement and Construction Controllers)
» Module Level (Read Only/ Modify)

Admin Portfolio ¥ | Analytics ¥ |Budgets ¥ | Planning ¥ | Engineering ¥ |Procurement ¥ | Construction ¥  Resources ¥ |Issues ¥ | Progress Photos V¥

Users User Rights Settings
Add User All Projects

<«

User ID First Name Last Name Company Name Email ID User Role Phone No Host Port
2296 Ajay Tandon EPC Projects Pvt. Ltd. ajay @epcprojects.com Engineering Team 9898764334
2299 Hemant Kumar EPC Projects Pvt. Ltd. hemant@epcprojects.com Procurement Team 9859664477
2298 Lokesh Kumar EPC Projects Pvt. Ltd. lokesh@epcprojects.com PMO 8505564356
2295 Munish Kumar EPC Projects Pvt. Ltd. munish@epcprojects.com Construction Team 9885431265
2297 Rajesh Kumar EPC Projects Pvt. Ltd. rajesh@epcproject.com Procurement Team 9898441776
2294 Sunil Vaishnav EPC Projects Pvt. Ltd. sunil@epcprojects.com Admin 5465878787
2311 Vaishnav Sunil EPC Projects Pvt. Ltd. snl.vaishnav@gmail.com Admin 9898776655
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Project Planning & Scheduling

MyEpcTeam

e Planning & Scheduling- WBS, Activities, Activity Scope, Steps, GANTT, Critical Path
» Resources — Manpower and Equipments
e Imports from MSP, Primavera and Excel

Activities Association with BOQ Items/Materials/Drawings

| Ring Road Proiect

I A - -
anming Engineering ¥ issmes ¥

KResources ¥

Frocurement ¥ | Consiruction ¥ Frogress Piotos ¥ |

Relations

AddActiviy TR % . %5 % AddRelationship [ Reset e
Activity Name s 1 | Duration Start Finish Prog. Delay 1 2118
(%) Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec Jan Feb Mar Apr May
[l Ring Road Project 268 01-Apr-18 24-Dec-18 0 0 — | Ring Road Project
Project Start Milestone 0 O0l-Apr-18[A]  01-Apr-18 [A] 100 0 @ Project Start Milestone
=l General Work 920 01-Apr-18 29-Jun-18 26 0 General Work
ROW 90  01-Apr-18 [A] 29-Jun-18 33 0 ROW
Site office setup 30 01-May-18 30-May-18 0 -20 Site office setup
Camp Set-up 60 01-May-18 29-Jun-18 0 -30 Camp Set-up
P&M Set-up 60 01-May-18 29-Jun-18 0 -30 P&M Set-up
=l Highway Work 246 01-Apr-18 02-Dec-18 0 -31 Highway Work
[ Chainage 1 246 01-Apr-18 02-Dec-18 0 31 Chainage 1
Clearing & Grubbing, Original Ground L... 94 01-Apr-18 [A] 03-Jul-18 0 -14 Clearing & Grubbing, Original Ground Level
Embankment 164 21-Apr-18 [A] 01-Oct-18 0 -4 Embankment
Subgrade 160 11-May-18 17-Oct-18 0 5 Subgrade
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Engineering Management

MyEpcTeam

Revision Control

Master Drawing/Document List

Drawings and Documents Status Tracking

Aligning of Drawings with Construction Activities

EPC Projects Pvt. Ltd. Y% 81 Ring Road Project :

AddDrawng R #
© )
DrawingName
[=I Ring Road Project
[=| Drawings for Highway work

[= Typical cross-section-1
Preliminary Drawing
Working Drawings
As-built drawings
Material Take Off

[= typical cross-section -2
Preliminary Drawing

Working Drawing

Admin ¥ |Portfolio ¥ | Analytics ¥  Budgets ¥  Planning W BodatiCudiifg
Download Drawing Comparison

Reports
R @ Reset

DrawingNo | Drawing Re...
RRR/TCS-... 02-Apr-18
RRR/TCS-... 05-May-18
RRR/TCS-... 02-Mar-19
RRR/TCS-... 24-May-18
RRR/TCS-... 07-May-18
RRR/TCS-...

RevNo | Current Status

1 Drawing Initiated

3 Issued For Review & Ap...

1 Issued For Review & Ap...

1 Drawing Initiated

2 Issued For Review & Ap...

1 Issued For Review & Ap...

Current ...

Discipline

30-Apr-18 Highway w...
02-May-18 Highway w...
02-May-18 Highway w...

Highway w...

02-May-18 Highway w...

02-May-18 Highway w...

Drawing ...

TCS-1/R0

TCS-1/R0

Record Dr...

TCS-2/R0

TCS-2/R0O

e ke Re

ke Re

Data Date : 01-May-18

Procurement ¥ | Construction ¥ |Resources ¥ | Issues ¥ | Progress Photos ¥

Download  Delay D...  Total Value

Vaishnav -

Earned Value Progress (%) Remarks

23 205 89

7 6 86

4 3 75

100 1 05 50
1 1 100

1 1 100

48 1 05 50
3 3 100

1 1 100

1 1 100
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Procurement MyEpcTeam

» Master Material List
» Bulk Material and Packages
* Purchase and Work Orders management

Store Management (Material Received and Issued)

Admin ¥ | Portfolio ¥ | Analytics ¥ Budgets ¥ Planning ¥ |Engineering ¥ Construction ¥ |Resources ¥ | Issues ¥ |Progress Photos W

e - B o orta S e ST
Add Material B 4 1 m Resel !
Item Name Item No Offer Received Vendor U.OM  Budgeted Qty MR PO Placed Recd at Site Issued InSto
[=I Ring Road Project
[=| highway material 101
Soil Type A 1 0 IS Construction Cum 200000 100000 6000 3000 2200
Soil Type B 2 0 IS Construction Cum 200000 10000 10000 5000 4000
Granular Sub Base (GSB) 3 0 Shree crushers Cum 161200 100000 100000 65000 20000
WMM 4 0 ABC crushers Cum 70000 50000 10000 7000 0
DBM 5 0 XYZ Hot Mixes Cum 30000 10000 5000 3000 0
DBM -2 6 0 XYZ Hot Mixes Cum 30000 20000 5000 2000 0
[=] Structure Material 102
Reinforcement Steel 1 0 Tata Steel MT 137 50 0 10 0
Cement 2 0 Ultratech Kg 1020290 250000 100000 70000 5000
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Construction MyEpcTeam

 Daily Progress Report
» Monthly Progress Report

Manpower and Machinery

» Automatic updates to Project plan

%3] ©DPR ~ MunPower | Machinary
Activity Start Finish Budgeted UoM Today's Cumm.  Progress Remark Issues
Units Quantity Qty (%)
Ring Road Project 0
= Ring Road Project > General Work 0
E ROW 01-Apr-18 30-May-18 15000 Mtr 5000 33.33
Chainage 1 8000 0
Chainage 2 7000 0
Site office setup 01-May-18 30-May-18 1 Lot 0 0
Camp Set-up 01-May-18 29-Jun-18 0 0 0
P&M Set-up 01-May-18 29-Jun-18 0 0 0
Ring Road Project > Highway Work 0
= Ring Road Project > Highway Work > Chainage 1 0
Clearing & Grubbing, Original Ground Level 01-Apr-18 03-Jun-18 800000 Sqm 1000 0.13 Back hoe break down for 2 hour... Backhoe Maintenance Contract
= Embankment 21-Apr-18 21-Sep-18 704000 Cum 1000 0.14
layer 1 704000 Cum 0 0
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Contract, Budget and BOQ

MyEpcTeam

» BOQ Tracking
» Cost Sheet
e Running Account Bills

» Change Orders

Add Ttem 4 1 i Reset
|| v ~
BOQ/Item Name
1 Ranchi Ring Road Project
[l Section-A

[ Site Clearance

Clearing and Grubbing Roa
= Earthwork

Soil Type A

Soil Type B

[=] Sub-base coarse

Granular Sub-base with Well Graded Material(CB...

[=] Base coarse

Wet Mix Macadam

1.1

2.1
22

3.1

4.1

i

UnitRate

144

765

1250

r
=

UOM

Sqm

cum

cum

cum

cum

Scope
Quantity

800000

704000
320000

161200

70000

Changed
Quantity

4000

Final Scope

Quantity

800000

708000
320000

161200

70000

Completed
Quantity

10800.00

23280.00
12220.00

4650.00

5260.00

g

Scope Amount  Change Amount Final Amount
1,04,03,71,250.00 5,76,000  1,04,09,47,250.0
1,00,49,99,000.00 5,76,000  1,00,55,75,000.0
32,00,000.00 0 32,00,000.0
32,00,000.00 0 32,00,000.0
15,25,76,000.00 5,76,000 15,31,52,000.0
10,13,76,000.00 5,76,000 10,19,52,000.0
5,12,00,000.00 0 5,12,00,000.0
12,33,18,000.00 0 12,33,18,000.0
12,33,18,000.00 0 12,33,18,000.0
8,75,00,000.00 0 8,75,00,000.0
8,75,00,000.00 0 8,75,00,000.0
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Dashboard and Reports MyEpcTeam

EPC Projects Pvt. Ltd. ad Projec Data Date : 01-May-18 Vaishnav «

Admin V¥ | Portfolio ¥ NV EINGT

Project Reports List 4 4 1 ofr b bI < Find | Next [~ |

7S]

» Project Status Summary
* Project Progress Curve
+ DashBoard Report Date : 12-Jul-18

Project Progress Curve

Construction Reports List

Project Name: Ring Road Project

¢ Daily Progress Report

¢ Monthly Progress Report

« QverAll Construction Status 120 — —=— actual

» Key Activity Status —e— forecast
* In-Progress Activities planned
« Delayed Activities

« Report by Activity Code
+ Hindrances

+ Punch Points

100 — A

Engineering Reports List 0]

+ Engineering Summary
+ Drawing Status

+ Delayed Drawings

+ Drawings By Discipline
+ Open Remarks

60 —

Percentage
DatzDate

404
Procurement Reports List

+ Bulk Material Status

+ Packages

+ Package Detail /

+ Purchase Orders g

« Stock Register 0 - . T T T T

s Meisrd Led 01 Mar 2018 01 May 2018 01 Jul 2018 01 Sep 2018 01 Nov 2018
RISURIEESAI20 01 Apr2018 01 Jun 2018 01 Aug 2012 01 Oct 2018 01 Dec 2018

20—

T T T
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Issues, Hindrances, Quality and Safety Incidents MyEpcTeam

* Issues Recording

* |ssue Assignment & Status Tracking
» Hindrances

» Punch Points

Safety Incidents

EPC Projects Pvt, Ltd. | (1298 Ring Road Project v Data Date : 01-May-18 Vaishnav

‘Admin v ‘Portfolio A 4 ‘Analytics v ’Budgets ¥ |Planning ¥ | Engineering ¥ |Procurement ¥ | Construction ¥ |Resources ¥ Progress Photos ¥

Add Issue Raised By: | —-Select-- 4l Tssue Type: | —Select-- 0 Assigned To | --Scleet-- 3 Status: -Seloct—- 4
Priority: | —Select—- s Pending With: | —Select-- s OpenSinee: | -Select-- s
Issue ID Issue Titie Creation Date Ciosure Date Status Priority Issue Raised By Issue Assigned To Pending With Details
1243 Inadeguate numbers of dewatering Pumps 18-May-18 Open High Vaishnav Sunil Vaishnav Sunil Vaishnav Sunil Details
1240 Frequent Brealdown of dumpers 11-May-18 Open High Vaishnav Sunil Vaishnav Sunil Vaishnav Sunil Details
1235 Quality 11-May-i8 UOpen iligh Vaishnav Sunil Vaishnav Sunil Yaishnav Sunil Details
1233 Inadequate contraclors resources 11-May-18 Open High Vaishnav Sunil Vaishnav Sunil Vaishnav Sunil Details
1221 Backhoe Maintenance Contract 02-May-18 Open High Vaishnav Sunil Vaishnav Sunil Vaishnav Sunil Details
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Progress Photos MyEpcTeam

EPC Projects Pvt. Litd. Road Project Data Date : 01-May-18 Vaishnav

Admin ¥ ‘Portfollo ¥ |Analytics ¥ | Budgets ¥ Planning ¥ | Engineering ¥ Construction ¥ | Resources V¥ ‘lssues A Al Progress Photos

Progress Photos

i Upload Photo i '
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Few illustrations of problems handled MyEpcTeam

DPR ° RA Bills Synchronized information to
reduce wastages
Punch Points
Plan
ISsues '

Manpower Mobilization

|dentifying points of delay in raising bills and
receipt of payments

Wastages/Redeployment

Engineering Drawings Material ROW Availability
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Key Considerations for IT Solution MyEpcTeam

 Source of information to be at input point

* Relevant reports to concerned people, as and when required

e Cost of IT and it’s Infrastructure management
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Solution Architecture MyEpcTeam

No Initial Capital Cost Secured on Cloud 2
S

g,

g

[a W

MyEpcTeam Application Server = N\ feemme e

S

Database — Data Storage Internet §
c

3

o

—

User-based Subscription Model

Project
Managers

No IT Infrastructure Management

Site Engineers

Short Implementation Time
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Implementation Roadmap MyEpcTeam

PHASE 1 | PHASE 2 | PHASE 3

_________________________________________________________________________________________________________________________________

e Requirement Analysis * Implementation Execution » Support & Maintenance
« Implementation Planning | ° Data Feeding * Advance Reporting
« Data Gathering -+ BasicReporting

.« Go-Live

» Data Preparation
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Value Addition MyEpcTeam

Time

Project

Cost Scope
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MyEpcTeam

Thank You

Shashi Verma :+919958291201
Email: shashi.verma@myepcteam.com

C-130 Sector-2

Noida, India

Pin-201301

Tel: +91 120 4864300

Fax: +91 120 4864333
Email: info@myepcteam.com
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